Skill Enhancement Course | g yo.. . 24701
A Semister-1ll, 2021-24 e

Elementary Computer Application

Time : 3 hours | UESE — (SEC - 1) Full Marks : 100
(Sc./Com./Voc./ General)

Read the Instructions carefully :

HISYTHT g3 {50 &1 03 -
1. Answer all questions.
et a9l &% S| T |

i

2. Each question carries 1 mark.
TAF T H 1 IFFH R |

3. Choose the appropriate alternative and darken the circle provided in the OMR answer
sheet.

mﬁaﬁﬁaﬁwﬁﬁzaﬁoquo Wommﬁfﬁéﬁnﬁﬁﬂmﬁ%ﬁ |

4. Use Blue/Black ball point pen to darken the circle.
TR i @ & e | / méafammw:mﬁnaﬁ |

5. Mobile Phone, Pager, Calculator or any other electronic gadget are strictly prohibited.
. OieTsd Wi, USR, Wmmmﬁmmmwwaﬁa% I

6. Open the seal of the Questton Booklet only after getting necessary instructions from
the invigilator.

friteres & Wﬁmmm%msﬁm gfﬁmﬁ%ﬂa@ﬁ |

7. Fillup the particulars asked on the front page of the Question Booklet and OMR Answer
Sheet very carefully at their proper places.

Te1-gRaT 37K 3o To momm%g@wm@ﬁawﬁﬁm%sﬁawﬁm .
grEgH A W | E@

Fill up the following :

121 BS B8 5B2Y 1 OMRAnswer D
i -5 ik ~ SheetNo.: 2 AT '

Name of the Candidate _ RBHIS H[ K KUMPR

Phhishe ¥ }émn

Candidate’s Signature - _ Invigilator's Signature

OX—3A/18 . , 3 (Turr!over)



ocessing unit are clas

1. Devices which are used to receive data from central pr

(b) Digital devices
fefirea fearsd

(a) Output/input devices

aMeqe /e feaTsd
(c) Signaled devices N (d) Output devices
i Teamed areeye fearsd

2 Theterm ‘Pentium'’is related to:

‘G’ W%’IW% :

(a) Hard Disk (b) Mouse
R - oed A
\ﬂc), Microprocessor (d) DVD
AT & - et A

3.  Which of the following are'components of Centrai Processing Unit (CPU)?
Rrrferfiag & & w2 e WA gfe (W) % weh 7
(a). Arithmetic Iogid unit, Mouse
- “STeRTOT T Th SIS, AISE
(b) Arithmetic logic unit, Control Un.it
\/ (©) Arithmetic; logic unit, lnteg-rated Circuits
(d) Control Unit, Monitor

OX - 3A/18 (2) | (Continued)



4. The most commonly used input device is : '

gy a7fireh ST 2N A wge feameE ®
(a) Mouse
{139

(c) Scanner

W

5.  Pressure-sensitive joysticks are also called :

B o e it e

(a) Non-movable stick '
R-=d Bl

(b) Joystigk
Sipii=c

| / (c) |sorhetriéjoystick

A Safe®

(d) Noneofthe menﬁoned .

et 7 2 A

‘Aby’ Keyboard .
$rarg

(d). Printer
firet

6. ___ canbeused todetermine the position on the data tablet. ‘

37 e Feuy et =t 3 o
J (a) St‘rip microphones |
f&m wTERIwE
(b) Signal strength
EESEIRIEN
(é) Coded pulse
Fifed gt
(d) - Either signal strength or coded pulse
a1 Y Rt o e ﬁ%—g 9eH

OX — 3A/18 ‘ (3)
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7. Computer or system peripherals that receives data from processing unitare called:

S 7 & 2o s ) AT o fereew e e &

@ Output devices ‘ (b) Receiver
(c) Pre-printed documents | (d) Analogue devices
g s . crmfEm

8. .Display technology that uses gas between two glass sheets is classified as :
3 e vite ¥ s e o1 S Y el Rt et Y anfigea e TR
(a) less-emitting diodes | - |
S
(b) Low emission displays-
Y -IcGSi TSI HLT
(c) Light-emitting diodes
R
" (d) Plasma displays

T yeRfa AT e

' 9. Display screen in which text is displayed in one color and background is displayed by
another smgle coloriscalled: =

i %@@ﬁqﬁaﬁmﬁ@mﬁmﬁhﬁmw%aﬁwﬁ\@ﬁe@mﬁmﬁhm
ST 8, I T AT @

(a) Monochrome screen , . \/(b) High resolution screen
() Lowresolutionscreen .. : (d) Medium resolution screen
9 STy dehed BhiA e T T
OX — 3A/18 . (4) |
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10. The amount of time required to read a block of data from a disk into memory is
composed of seek time, rotational Iatehcy, and transfer time. Rotational latency refers

(o IR

e | AW T 221 ¥ U Ao 1 U@ o FTT aTravaes qud <6l qTa Hich 2rgH, YTt wedl
3T Zraw 2rgn @ = et B | ooff Rerefan ———— = wRiia R

(a). Thetime its takes for the plattérfo make a full rotation

Tt 31 I FER TR § T 9T 6

\_~(b) Thetime ittakes for the read-write head to move into position over the appropriate

track

-W%‘éﬁm%mm@ﬁﬁaﬁﬁaﬁww
(c) The tlme it takes for the platter to rotate the correct sector under the head
oreht 7 35 % Y et v A g o e '
(d) 7 Nonebf these '
T QI3 T
11. The average time required toreacha storage location in memory and obtain its contents .

is called the
Mﬁ@hwwq@ﬁmmmﬁ%mwmm@
FESE@E | -
(@) Seektime A
A Y AT R
~(b) Turﬁaround time
(c) Access time -
'(d) Transfertime
g 2

. OX—3A/18" " - | xi(B) | (Tum over)
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12. Whatis the value of 24 ?

29 R R 7

(@) 8 Ab) 16
¢ RE
(c) 32 ' ' d 2
R | ?

13. Convert (11001,001)2 (binary) to decimal :

(11001001),, (aTett) = Zwwrer f e :

(a) 2001 , v(b) 201

 Rooy vl 9 REY

(c) 20 ' (d)’ 1000 -
o 2000

14. The basic logic gate whose output is the complement of the input is the :

e TR e v IM9egE T 71 T R T8 2 -

(a) ORgate (b) . AND gate
ORM - _ AND 1z -
_ (o) NOTgate " -' | (@) NAND gate
NOT i | : NAND Tz

15, Keyboard and mouse are :

. FEg iR uEE R
' ‘(a) DC S’éViceS ] , (b) Analogue devices
(c) Truthtable devices ‘ - /(d) - Inputdevices

g 2uw fearsw i e feamgw

‘OX-3A/18 - (6) (Continued )



16. Function of running and loading programs by use of peripherals is function of :

IRReT & I9AIT g0 N e 3 S A o

. (@) Operating system , (b) Inquiry systém
(c) Dump programs (d) Function system

17. What does GB stand for'in the world of computers ?

- R 6 g § GB 1 e @ 7
« (@) Gigabyte . (b) Gameboy
e | Ao
(c) General Business | i | (d) " None 'ofthese

G AR A T A 1S T

18. Software which controls general operétions of computerr system is classified

as: | |
oz o 35 T i ) e 8 R v 2 g e
(@) Dump programs . \ :
(b) Function system
« (c) Operating system

Rfen R
(d) Inquiry system

FCLIERIS]

~ OX-3A/18 S EA T 3 (Tum over)



19. In microcomputers, operating system is usually étored on:
gl e H, atfen e AR 9T @R frar ST :
(@) Random access memory
Yo wiE At
(b) Read only memory
B st A
.~ (c) Pemanent merﬁory
TR W
(@) Temporary memory
swah G

20. Transmission media which transmits voice and data through air high frequency radio

wave s :

sherer i ot S Tty Y il 3 w9 3 e AT & S i 2 A s
\/ ~(a) Twisted pair . ' g ((b) v..Coaxial cable |

- (c) Satellite _ " (d) Miérowaves

' 21. _______isthe mostwidely used local area network protocol.

————wﬁmmﬁsﬁqm%maﬁ 1T SR Ui Yeud W & |

(aj Token Ring i (b) TokenBus
v (.c) Ethernet £ Gl (d) None ofthese =
sae R T @ i 7

OX-3A/18 (8) . (Continued )
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22. Inthis topology thereis a central controller or hub :

8 tiSll § U Heel sheler 91 8 BT @
Na) Star . (b) Mesh
R g
(¢) Ring . (d Bus
o i i

23. The amount of data that can be carried from one point to another in a given time

period is called :

Rrelt RffRr Tty o fig @ Gk g o & T o1 R A 2 A A

g: - W i
(a) ScO'pe |
(b) Capacity
&Hdn
+(©) Bandwidth
. Sefrew |
(d) Limitation
g ‘

24. The_____ _isthe physical path over which a message travels.

i v R WO TR AR |

(@) Pa_th il g b) Medium
qq T n - Hhieam
. (c) Protocol b e : _ (d) Route

OX - 3A/18 : '_ (9) (Tum over)



25. In which of the following form, data is stored in computer ?

FrefiRaa # @ frg &9 §, 9 § a1 audia frar sman @ 7

(a) Decimal v (b) Binary
CHERER gt
(c) Octal | ~ (d) HexaDecimal

26. Ifa computer has mére than one processorfhen itis known as :
af% ek e § wh A 3t Mo 3 o 33 Frw w9 S e 2 7
(a) Uniprocess ‘ | 1b) Mulltiprocessor
(c) Multithreade_d ; (d) Multiprogramming
27. Elément which contains computer administrative tools is calléd :
s e foret g T ST 3 8, e €
(@) Control panel . )
Pt
(b). - Start button
e W
- (c) Internef'explorer
(d) Recyclebin
e et

__';ox;-3A/18 (10)
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28. You wished to justify text over the height of paper, which option will you choose :

39 T 6l HET3 T 1S H Tl ST I €, N9 -1 ferhed g 7
(@) Page Setup from File menu

HIEA U=/ st D3
(b) Paragraph fror.n Format menu
&Y T &/ ITg=Da
(c) From Formatting toolbar
BT AR H
(d) Fontfrom Format Menu
TREY B | Hiee
29. The 1"ile type __ indicates th_e file is aword ddcument.
mmm—éﬁmm%%ma@aémﬁa% |
(a) .msw i (b) .wor
(c) .wrd o -~ (d) .doc v’
30. Tomove thé cursor pége to page of document : .
Pt A1 Y SRR % A R R A ¥ R
(@) Ctrl+PgDn b . (b) Ctrl+PgUp
</ (c) Both(a)and (b) ' , (d) None of these
L@ cEawi
31. Which of the following are word processing software ?
Prten & -z 5 s e & 7 '
(a) Word Perfect _ (b) EasyWord
7 T ; : whad
(©) MS Word Al () Allofthese
TWowgoqd . | wft
OX - 3A/18 o A1) (Tumover)




32. Text-styling feature of MSword is :

THo THo I8 T IR TTETeNT B @ -
(@) WordColor (b) WordFont
EECISH | TEH<
_(©) WordArt : () WordFil

g - adfm
33, Wﬁich function in Excel tells how many numeric entries are there ?
eier 8 - e e e e e e & 7
(@) NUM (o) COUNT
(c) SUM | s - (d)" 'CHKNUM
34‘. To create a formula, you can use :
g T ¥ R T ST R
" (a) Values but not cell reference
(b) | Cell reféf.ences'but notvalues
e wef <aT € AfeRT 1 T
(c) Values or cell reférences although hot both at the same time
s 1 e <t v s o A
~~ (d) Value and cell references

e s v s

OXZ3AM8 . “(12)
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32. Text-styling feature of MSword is :

o THo T FHI IR T B T -
(a) WordColor (b) WordFont
FEH | TEHI
_-(© WordArt > (d) WordFil

AL ' et
33. W_Hich function in Excel tells how many numeric entries are there ?
TR # - T a2 26 forert e wffia € 7
(@ NUM ~ (b) COUNT
(c) SUM | | : (d). CHKNUM
34. To create a formula, you can usé :
Y S ST
@ VaIUes, but not cell reference
(b) . Cell refér_ences but not values' :
act deof 31 @ Al AR
(c) Values or cell reférences although notlb_oth at the same time
mmﬁa@ﬁﬁaﬁ@tﬂmﬁﬁ?ﬁ
;/ (d) Value énd cell references

e o dw g

OX — 3A/18 : S (12)
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35. Latest version of Microsoft Excel is

ATSSh AT TERIET T Telad HERt — ¢ |

() 2007 " S((b) 2010
Roob £ ' 080

© 2015 | @ 2016
Ro%Y . _ | . 02§

36. Firstspreadsheetwhich was developed

et e o ————— P T 1
\/' (@) Microsoft Excel ' , (b) Visicalc
(©) Lotus 12-3 ‘ oy (dj None of these
FE-13-3 SN _  wEAReE
37. The — feature of MS-Excel quickly completes a se;ies of data.
- TR Y~ e 21 o o e 1 el 4 A 1
(a) Auto Complete ' N W (b) Auto Fi|ll
S CH L A ; L B S
() FilHandle (@ Sorting
' 38. An electronicvpage ina presentatior_\ris called .
| R T R S ad
@ Side, o o s (b). e-slide
LI | §-%ags
(c) e-page o, ol C(d) . Page
$99 . e

OX-3A/18 x i (13) | (Tum over)



. 39. To open the existing presentation, press :

Asier A @en & fere, @and

(a) Ctrl+L (b) Ctrl+N
et + L helel + N

(c) Ctrl+A « (d) Ctrl+0O
HA +A e+ 0

40. Special effects used to introduce slides in a presentations are known as :

SR 3 e 1 ¥R 0 5 o el fov T e syl bt e e T AT

27 |
(a) Transitions (b) Effects
v~ (c) Customs animations co : (d) Annotations

41. In PowerPoint, slide sortevr command is found under which tab ?

qﬁtﬁézﬁmlssqﬁt*qis%aia% Il 9T ST @ 7

(a) File _ (b) Tools
1T | .

(©) View ' ' ' : \/(d) Edit
2 ufee

42. Which of the following view is not one of PowerPoint views ?

fPrafaftad # @ HH-81 3 dlaise <« 7' QU T R ?

wa) Slide Sorter . (b) F‘resentatfon
. T L3IEE , s
(c) Slide show (d) Normal
wge W . qT

. OX-3A/18 . (1‘}) © (Continued)




43. To create a new blank presentation you gould

e 4 e sregfe T 36 g o ————— HUERAE |

(a)  Click on the new button : (b) Use the file new command

A e T TR ' . g =Y S T IHENT
./ (c) Both(a)and (b) (d) None of these
(@) W (b) a1 ' ’ g B IS Tl

44. |In Excel, Row are labelled as

Wﬂﬁﬁﬁ—_%wﬁéﬂa%mw%l

(@ A,B,C etc. | : o) 1,2,3etc
g, f, demk i g, R, 3R

(c) A1,A2etc (d) $A%1, $AS2, etc
A1, A2 3R ‘  $AS1, $AS2,31R

45.' What characteristics of RAM memory makes it not suitable for permanent storage ?

hﬁﬁﬁﬁaﬁq—@ﬁﬁﬁwsﬂwm%ﬁqmwﬁw%?

(a) Tooslow- i (b) Unreliable
g | e
< (€) ltisviolatile - , (d) Toobulky
| T ABRE | Tgd Wl
;16 Base 10 refe'rs to which number siistem ? -
T 2o rw wE TUTTedt st Fefifa s %
'(a) Blnary _ (b) | Octal
(¢) Hexadecimal - ' \/(d) Decimal
OX—3A/18, | (15) (Tumn over)



47. Convert the binary number 1001.0010 to decimal :
SIEH W& 1001.0010 Y Tvmerd § e -

(a) 9.05 v (b) 925

Q.04 Q.Y
(c) 9.5 | oy ' d) 9.125
R Ay » O RRRY

48. Which of the folloWing logical operations is represented by the +sign in Boolean

algebra ? : ‘
e st 3 Frefirfae i 9 -an afen s Tzt T g 7
(@ AND - | o) OR
3R = ; - a
() NOT | (d) Noneofthese
o O cHam
49. Physical orllcsgicalana'rlge'mentof network is : |
s s e e s |
@) Topology e (b) Routing
(c) Networking T . (d) Noneofthese }
R P
5b. This topology requirés multipéint connection : ‘
- §8 IS B WA FA Y ST A 2 -
- (@) Star - (b) ~ Mesh
(¢) Ring | ' _Ad) Bus
far |

OX-3A/18 » (16) - (Continued)




47. Convert the binary number 1001.0010 to decimal :
=& WA 1001.0010 Ft FIe f e :

(a) 9.05 ' (b)) 9.25
R.oy 3.4
() 95 - = | (d) 9.125
Y 5, 5 O R.3RY

48. Which of the following logical opérations is represented by the +sign in Boolean

algebra ?
e s 3 Frferian § 8 - e s g 2 < T 2 7
(@ AND () OR
S S n
(©) NOT | (d) Noneofthese
@ A0 o e
49. Physical or'lo‘gical arra.nge.mehtof network is : | | '
Yok A e a1 e TN 2
‘./(a) Topology ‘ | (b) Routing
(6) Networking S .o (d) Noneofthese

50. This topology requires multipdint connection :

4 wﬁﬁﬁn@qﬁzmﬁmm%:

(a) Star ' : (b) Mesh
DI R e i i
{c) Ring e (d) Bus

OX -3A/18 (16) ~ (Continued)




51. Which among the following is engine of computer ?

Frefaftad # @ F-a1 S F AR 7

(a) Mouse : : ‘ (b) Scanner
RIS | L
(c) Monitor a /(d) Processor

52. SMPS stands for:

" (a) Switch Mode Power Supply | ~ (b) Simple Mode Power Supply
Rude Ao et e vt 1 e
(© ' Serial Mbde Power Supply | _ | (d) Series Mode Power Sﬁpply 2

hifrer e ot o ol e el oo

'53. Trackballis:
Sohallel @ :
(@) Two-dimensional positioning device
 fe-smh defrafi R |
\'/-(b)‘ Three-dimensi‘onal‘positioning device = |
-t s feaea |
(c) Pointing device ' . _ |
(d) Noneofthese '

gﬂﬁ#aﬁiﬁ‘aﬁ

‘OX-3A/18 ‘ (17) | ' (Tum over)
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54, A common device for drawing, painting or interactively selecting coordinate positions

on an objectis a:
o s R i, R o afa: Fren w @ i R S % feru, vk
T ITH @

/ (a) Imagescanner ‘ (b) Digitizers
oft @ - R
(c) Dataglove : (d) Touch panels
2T T ‘ & O

55. Marker on computer screen which is used to show current position of user is called :
o A T T S sl ) e fuf A R ¥ R s fe s g,
FEATIR :

(a) Colored marker

\/(b) Cursor

.

(c) Position checker , (d) Screen contents

feufa e \ whA amft

56. New technology names ‘LE’D" is abbreviation of :
- 1§ i 'LED' 1 Wi T R
(a) Light-emitting diodes
~(b) Liquid emitting displays |

(© Less emitting diodes
FH IeGSih i

(d) Low emissiondisplays
W Ao NERId T

OX—3AI18 § : (18) (Continued )



57. Marker on computer screen which is used to show current position of user is called :-

WWWFW@W@W%@W%%&WWW%,
FHEATAT § : j e |

(a) Colored marker g Vs (b) Cursor
e st 2y
(© Position checker ‘ (d) Screen contents

ferfa whes Shie gt

58. Computer or system peripherals that receives data from processing unit are called :

qﬁﬁﬁn?{ﬁzﬁéﬁmmaﬁéu@mﬁmﬁﬂmmﬁ%:

« (@) Output devices A (b)  Receiver
(¢). Pre-printed documents ) _ (d) Analogue devices
59. The process of removing unwanted part of an image is called :
e 5 & araif o 1 ger ) S e ¢
‘/(a) Hiding | vl e perdering
(© Cropping N (d) Cuttjng
ETe I FE
60. Von-Neumann architecture is
a7 =i AAfeheat i (e
(@) SISD ‘\/ (b) SIMD
woEd L T
(c) MMD | d) MISD
e ) ‘ WEIHGE] |
OX — 3A/18 ‘ : (19) (Turn over)
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. ) 1 ?
61. Which of the following is the correct Boolean expression for AND Gate

Freiferfiaa f & #9-1 AND Gate wdh aftre s & 7

(a)-A+B . | el (b) A-B
.~ (c) A-B 5.6 | (d) None ofthese
i & IS Tl

62. Convert the following decimal number 21 to binary number :

ﬁﬂ%ﬁgamaﬁ@mzaﬁmmﬁmmwiﬁ: .

(@) 11001 o .~ (b) 10101
ooy ' 20308
(© 11101 Ee -(d) 00101

33208 - - 00%0% -

63. How many megabytes is 16384 bytes ?

fohe rTrTse 16384 Srgem & 7

@20 - o | (bj 18
R Y e

© 16 & - S s
38 e L AT o

64. Which of the following is'not a Valid Boolean Expression ?-

o=t & a4 R e 2 7
(@) A+B e ) A-B
'« AIB . | | (d) None ofthese
T A = 7t
OXEsanE 6y
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65.

66.

67.

68.

Specialized program that allows user to utilize in spedific application is classified
as:

%ﬁmmsﬁmﬁﬁﬁumﬁmmﬁﬁwﬁ%% aﬁaﬁqm%m
TR ?

(a) Relative programs \/(b) Application programs

Ny FEEy STIRANT AT
(c) Replicate programs ~ (d) Noneofthese
EIRER TG i | S | TH | s e

Program which exactly perform operaﬁons that its manual says is classified as :

sﬁm%ﬁmﬁmm%sﬁmﬁgm% ITgAR i &

(@) Unreliable (b) Unstable functioning

e - e S
- (¢) -Robust o 4 "V/(d) Reliable
Application program example includes :
T st ¥ e e
(@) Payrollprogram | v (b)) Desktdp program
(c) Publishing program ' (d) Editing program

Application prorgram used with all documentation is considered :

Mm@ﬁ%mmﬁqmwmﬁmmﬁw%m%:

(a) Applications package i (b) Replicate programs
e YT : FRI AR
. (c) Applications brograms et . \/ (d) System programs
A HRIEHH peae Rreen wm
OX-3A/18 | i (21) (Turn over)



69. What's the best way to protect your hard drive data ?
39 §TS FI5a 321 h GRATT @A o1 W 317 et a1 & 7
\/(a) Regular backups
Fafia seserg
(b) Periodically defrag it
- ® T fe =
(c) Run chkdsk at least once a week
YwiTe ¥ W | N Teh ) chkdsk Semd
(d) Runscandisk at least once a week
T H 9 | HH Tk TR STsws Tand
70. The wireless LAN~speciﬁcation is defined by IEEE, called, ________which covers

the data iink_and physical layer.

FreE o= fafvéw IEEE mw&wﬁa%mw%,ﬁﬁ E—C T 1 S T
fereh 31 st wea it TR a2 1 A

« (a) IEEE 802.2 | (b) IEEE 802.11
() IEEE 892.3_ | d) IEEE802.5

71. Who was the father of Internet ?

$ote B T 7
‘(a) Charles Babbage " (b) 'vintCerf
Sl ECE _ | . fe o
(c) Denis Riche . (@) Martin Coop
Py L ' s e
OX-3A/18 (22)
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72. The First Network :

%'Fﬂﬁ?a%
(@) CNNET L ~ (b) NSFNET
(c) ASAPNET \./ (d) ARPANET

73. Physical or logical arrangement of network is :

Azaeh i siifores a1 it saea 2 -
.~ (a) Topology -~ (b) . éouting
aowrh =
(€) Networking - ey (d) Noneofthese
e i
74. Keyboard ______isa device.
g T ——— feama @ | ek
s (@) Input Sl (o) Output
() Both(a)and(b) § (d) None ofthese
(a) & (b) F o - AR
75. Computer Menu is a collection of : l
m@tﬁ‘i@m%
() Commands : ' (b) Ordefs
SRME | U I
(¢) Instructions : : (d) lcons

OX — 3A/18 A (23) (Tum over)



76. Fullform of URL :
o 3o Teto T qof &9 2

(@) Uniform Resource Locator ' (b) Uniform Resource Link
(c) Uniform Registered Link ' (d) Unified Resource Link

77. Documents, Movies, Images and Photographs etc are stored ata:

(a) Application Sever | RS - (b) Web Sever
A TR P |  yw ki

(c) Print Server v(d) File Server
fire vkt .ﬁ‘ ' | : q:rsa i i

 78. Howcanyou break the current column and starta new co!umn lmmedlately ?
3T FAHH FieT Hr 2 ors Ty § aﬂzgta@wwgaaﬂm% ?
v (@) Press Ctrl + Shift + Enter " dN<(b) PressAlt+ Enter
(c) Press Ctrl & Enter ' _ ‘ (d) PressAlt+ Shift + Enter
79. To open Columns dialog bcsx quickly : | |
F ST S ) et @ 3 fora -
(@) Double C|ICk on the left margin area of ruler
- TR A T 8 R e e
(b) Double click the space between area on'ruler
ST R 8 % <t ) e e et Frers
(c) Double click thé right margin in ruler

’wﬁmwﬁqmmmaﬁ

\/ d) Allofthese

FAah

. OX-=3A/18 _ (?4) (Continued)




80. Text boundary can be displayed or Hidden from:
S | i wefia QUTT ST HehdT % :
\VAC)) Autq text option from Insert menu
B S SRR S —

(b) Options from Tools menu
e 4 freew

(c) | Customize from Toolé menu
ST A X s

(d) Allofthese

|/ ot

81. MS Office provides help in many ways, which of these one of them ?
o THo mﬁmﬁmmw% AT
(@) Whatisthis? ' (b) Oﬁ” ceASS|stant
T TR ? e | BRI e T
" (©) Helpmenu : (@ Alofthese
WEEA A s ¥ wh
~ 82. Which ofthe following is not of the merge process ? A
Freferfiam 3 & w1 ot slieen o 71 2 7 |
(a) Sortthe data source records
21 A et = e
(bj Formata méin document

Toh YA RIS i TEUA
/ (c) Edltadata source

21 9id guTfed i
(d) Merge the two files to print or create a new document

@wmﬁzmﬁmmﬁ%ﬁqamaﬁﬁﬁ

OX-3AM8 .. (25)

(Turm over)



83. Which function in Excel checks whether a condition is true or not ?

TR § PA-|1 G e it @ o e g & el 7

(@) SUM
QT

o (© F

AT

(b) COUNT
FHI3E

(d) AVERAGE
afraa

84. What type'of chart is good for single sefies of data ?
821 <t Uehet e o fore v wen 1 = e R 7

(a) - Column Chart
CARLACIC

(c) Pie Chart
qré =

85. Lotus 1-2-3was used as _

ARed 1-2-3 HIIGIT ————

(@) Word application
A G
(c): Powerpoint

- *

qraqrge

«(b) LineChart
g =1
(d) ConeChar
M AN

% & 1 foran St e |
«— (b) Spreadsheet
(d) Noneofthese -
1 A g T

86. When you will save the file of Excel it will be saved with which extension ?

ST 3719 TR ! FI5eT ! ¥ 41 ) 98 o0 TRTH & |y B gt ?

(@) .xls

. (c) .xisb

OX - 3A/18

(b) .xisx

/(d) All of these
T @ o

(26) . ( Continued )



87. Inaworksheet you can select :

TN T 3119 ATz Ty
\)<(a) The entire worksheet - (b) Rows
9w < et
(c) Columns ' \/(d) All of these
HicTq , 0 @ oot

88. Which of the following is the default page setup orientation of slide in
‘ PowerPoint ?

ﬁﬁ%%ﬂﬁﬁ@m—mqﬁmﬁzﬁmm%ﬁaﬁa@zmaﬁﬁ@m% ?

(@) Vertical - \~ (b) Landscape
.m . w | - |

(c) Portrait . "~ (d) Noneofthese
i | | o A T

-89. This task pane shows the design that is currently being used in apresentation :

T 14 Hoieh 36 FSeme 1 fman 2 S adae § wegfoeo § s s @i

- (@) Slide Show (b) Slide Style
- e o wge deft
(c) Slide Design (d) Slide Fomat

LNIESS EEIEC SNIECR LU

" 90. In slide master footer area appears at :

TS 7 TR X e e e B - |
s I(a) Left of the page (b) Center of the page
o1 % aTd - o0 & = A
(c) Top ofthe page ' (d) Bottom ofthe page
My ERE
(27) - | -+ (Tumover)

OX - 3A/18



91. To Preview‘a Presentation, Click .
YRR T Qe e ¥ vy, ————— R e |
(@) Print Preview button on the QuickAccess Toolbar
fire vieg w1z 31fa <t forep @ ‘c,j\?ﬁﬂ“{
(b) Office Button Print Preview
i e e ey
\/ (c) Both(a)and (b)
(a) T (b) THT
~(d) None of these
T @ g T
92. The Save as dialog box cén be used:
5 0 3 gt WS it a1 T R S e B
, \/(a) For saving the file for the first tlime
I bl Teeft TR | i < ferg
(b) To save file by some alternative name
2 mﬁﬁaﬁ%@mmﬁﬁamﬁ%ﬁm
(c) Tosave fileinaformat other then word *
oI5 1 9 % ST 37 e 3 A e %
d) Al ofthese_ ' ‘
7 9 wft

93. Which PowerPoint feature allows the user to create a simple presentation quickly ? -

Wﬁﬁﬂ-ﬁﬁﬁwmﬁﬁﬁﬁﬁwwuﬂﬁmﬁa&a@qﬁm% ?

(@) AutoContentW|zard | (b) " Transition Wizard
- (c) 1ChartWizérd ‘ \/(d) ‘Animations
OX-3A/18 - (28)

(Continued')



o4. Where is data stored in a computer 7 '

e # 321 infie vt @ d 7
(a) Monitor : (b) Keyboard 2
A g
/(© CPU (d) Mouse
RN I
95. A nibble is composed of : |
o e R R
v (@) 8bits | ‘ (b) 4 bits
' chem Y : ¥ foem
(©) 2 bits (d) 6 bits
Ifrm ' e 5 6 ey

96. Which of the following devices is used to obtain audio output ? -

ﬁmwﬁamﬁwmm%%q%qumm%?

(@) Speaker " - (b) Screen
AL e L ) T
(c) -Printer | ’ (d) Noneofthese

fret e T & g e
97. Which of the following is the shortcut for cutting a textline ? |
Pt & @ -1 3 A B e ¥ Rio widae 2 7

(@) Ctrl+V e e \A) Ctrl + X
W*‘V . A ¥t + X
(©) Ctri+C e . (@) cti+B

FA+C 5 e

0X—3AI18‘-’ i (29) | (Turnover) .



o4. Where is data stored in a computer ?

gt 7 31 W el A 7
(a) Monitor g 6314 Keyhoard
e ' CACIK]
\/(C) s ' (d) Mouse
95. A nibble is composed of : |
o P s A R - -
(@) 8bits | (b) 4bits
¢ Toem | o SN e ‘
() 2 bits | e
foem ' _ PR

96. Which of the following devices is used to obtain audio output ?

et aTTRege = SHifea aseye W A & foru firg serr s fopan T & 7

(@) Speaker i A (b) Screen
(c) - Printer _ = jor | | (d) None of these ,
frx S FHARE

g7. Which of the following is the shortcut for cutting a text line ?
e i Q -1 25 A5 A led & fw widewe g 7

(a) Ctrl+V S ‘ ' \A) Ctrl + X
ALV ST dm e X
() Ctri+C | . (d) Ctl+B

0X—3Al18‘_. vl i i (29) (Turn over)



'98. Whatis 1+ 1+ 1in binary and decimal form ?
fyomdt o queE@ EaH 1+ 1+ 1 FLT

(a) 10,3 v ()

%o, 3

(c) 11,2

23, R
99. In binary numbe.r system, 0+ 1= ?
T TR R A0 +1=7
@ 0 e e e B )

o

R

(d)

v @ 11 e s s ().

11, 3
e, 3
101,4

0%, ¥

10

o

100. A hard disk is divided into tracks which are furth;er subdivided ivnto. s
o 7 e < v i o s R omh - R f e 2

~(a) Clusters | ' Sectors

FoeeT | e
(© _Cylinde'rs\-/' > (dy
Referoeg it o
—
OX-3AM8" e (30)

qet 4

Heads

LU
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